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Config Files    (*.ALC)
See Also Independent Config Files
See Also Arranging Almanac's Desktop

Almanac's File menu includes the familiar Open, Save and Save As selections.    These 
commands operate on config files, a file format used by Almanac that allows calendar 
presentations to be customized without changing the underlying data associated with the 
calendar.    The DEFAULT.ALC file (initially created by SETUP) is used to specify the default 
values if a config filename is not specified on the command line used to start Almanac.

Config filenames use the extension ALC.    These files are used to control (a) where 
Almanac reads and saves calendar data and (b) the presentation format used to 
display and print the data.

File.Save or File.Save As
Select File.Save or File.Save As to store the current settings into a config file for easy recall.   
The current state and position of each of Almanac's windows are also stored into the config 
file when a file save is performed.    If you would always like Almanac to save your settings in
the current config file when you close, select the Options.Save Config on Exit setting.

Most of the settings that are maintained in a config file are accessed from Almanac's Options
menu.    Additional values are located in the File.Page Layout dialog and the upper sections 
of the Main and ToDo pull down menus.    The settings that you choose affect the display 
and/or printing of your calendar data.    Examine the wide range of options available from 
these menu selections to customize your calendar to your needs and preferences.

Where Almanac Accesses Data
In addition to specifying values that control the presentation of calendar data, config files 
specify where to find the data.    The config file points to the data but does not contain the
data itself.

Calendar data can be entered in the Main and tool windows of Almanac.    This information is 
maintained in (1) overlay files and (2) Almanac data base files.

1)    Overlay files can be added or removed from a calendar display using the 
Options.Overlays dialog.    Up to fifteen overlay files can be in use simultaneously.    The 
drive, path, and filename for each overlay can be saved in the config file.    This feature 
allows overlay files to be created and maintained independently of the config file(s) that 
reference it.    It can be used to simply organize your overlay events into different overlays 
by category or, in the case of networked users, to allow many people to view overlays that 
are updated at central locations.

2)    All data that is entered into the Scheduler, ToDo, Notes, and Phonebook tool windows is 
stored in data base files that Almanac maintains in a data base directory.    The name of the 
data base directory is controlled from the Options.Directories dialog.



Independent Config Files
See Also Config Files

 

Calendar data can be entered in the Main and tool windows of Almanac.    This information is 
maintained in (1) overlay files and (2) Almanac data base files.

First, create a new database directory, anywhere on your machine.    Second, within that 
config file, select Options.Directories, and change the database pathway to point toward the 
directory you previously created.    This will reset your database, to store independent files. 
Last, select File.Save As, and name the file (no longer than eight characters, with an ALC 
extension).



Almanac will not create a new directory on your disk.    You can use Windows File Manager or 
use the MD command from a DOS prompt.    If still unsure, please consult your Windows or 
DOS manual.



Database Files
See Also Export/Import

Schedule Items/General Notes
Scheduler items, notes attached to them, or any General Notes, are stored in a month-
year.ald format (jul-1994.ald).    These files are maintained in the \ALD sub-directory 
(installed with Setup), or the directory you have designated as the database (set in 
Options.Directories).

ToDo Items
ToDo Items are maintained in todo.atd.    Any notes that you attach to these items are 
maintained in todo.ald.    Upon archiving a todo item, a file todo-hst.txt is created, any 
any subsequent todo item archived will be stored in this file.
 
Phonebook    
Phonebook entries are maintained in phonebk.alp.    Any notes attached to these items are 
maintained in phonebk.ald.    



      Tools
See also Tool Bar

Tool Windows

Main Window

Notes Window
Phonebook Window
Scheduler Window
Search Window
ToDo Window



     Menu Commands
Listing of all menus, and their commands.

File
Open
Save
Save As
Export/Import
Page Layout
Print
Print to Metafile
Printer Setup
Set Wallpaper
Exit

Edit
The Edit menu is used to edit text within the Notes window.

Undo
Cut
Copy
Paste
Clear

Options
The Options menu contains selections which allow you to customize the appearance and 
operation of the calendar and accessories.

All options are saved in the config file and restored when the file is re-opened.
Calendar
Scheduler
ToDo
Phonebook
Overlays
Colors
Directories
Fonts
Icon Clock
Location
Sound
Wallpaper
Toolbar Hints
Save Config at Exit



Main
Selections on this menu are related to Almanac's Main calendar window.

Year View
Month View
Day View
QuickEdit
Date
Today

ToDo
View Pending / View All
Add
Modify
Check Complete
Archive

Window
The Window menu is provided for keyboard users.    Almanac's tool buttons provide these 
functions for the mouse.

Calendar/Schedule/To-do/Phonebook/Notes/Search
Arrange All
Reset Desk

Help
Contents
Seach for Help on
How to Use Help
About Almanac



Opens an existing config file



Saves the current config settings and overlay filenames to the active config file.



Displays a standard Save As dialog to save the current config settings and overlay filenames
to a new config file.



It will let you Export/Import data from/to Almanac.    See Export/Import



Used to define the page orientation, header/footer settings, and page margins (see Printing).



Instructs Almanac to send calendar or schedule information to the printer (see Printing).



Displays a standard Windows Print Setup dialog.



Captures the Main window in the current Month    or Year display only, and converts it into a 
Windows Metafile. See Print to Metafile



Selecting this option causes Almanac to install a background image of the current contents 
of Almanac's Main window onto the Window's desktop.



Closes the Almanac program.



This option becomes available after any changes have been made to the text in the Notes 
window.    Selecting it will undo the last change which was made to the text.



Removes the currently selected text in the Notes window and places it in the Windows 
clipboard.



Copies the currently selected text in the Notes window to the Windows clipboard.



Pastes text from the Windows clipboard into the Notes window at the current entry point.



Deletes the currently selected text in the Notes window.





Activates the Calendar Options dialog.    Used to set options for the calendar operation of the
Main window.



Activates the Scheduler Configuration dialog.    Used to configure the Scheduler tool window.



Activates the To-Do Configuration dialog.    Used to configure features of the To-Do tool 
window.            



Activates the Phonebook Options dialog.    Used to configure features of the auto-dial feature 
of the phonebook.
Exporting or importing of CSV (comma separated value) phone and address data is also 
available through the File.Export/Import dialog.



Activates the Calendar Overlays dialog to configure or edit overlay information for the 
current calendar. 



This selection activates the Almanac Color Settings dialog.    Used to customize Almanac's 
on-screen display. 



Used to view or change disk directories used in Almanac.    The Default Overlay Path is used 
to initialize the file open dialog when opening overlay files.The Data Base Path is used to 
store all information entered into the Notes, Scheduler, ToDo, and Phonebook tool windows.   
Almanac's SETUP utility initially creates a directory named "ALD" for this purpose (located 
underneath the path that you installed Almanac to). 



Activates the Almanac Fonts dialog to change screen and/or printer fonts.



Almanac can minimize itself to a desktop clock rather than a regular Windows icon (see Icon 
Clock under Running as an Icon).
Selecting Icon Clock will activate the Almanac Icon dialog to allow the iconic clock to be 
enabled/disabled and to reveal more options.



Activates the Current Location dialog used to select a geographical location.    This 
information is used by Almanac to calculate time zones, sunrise and sunset time, and 
phases of the moon.



Activates the Almanac Sound Setup dialog, used to associate digital sound files to Almanac's
audible alarms.



Invokes a dialog used to direct Almanac to automatically set Windows' wallpaper when 
Almanac is started.    Almanac can set the wallpaper to any of the views provided by its Main 
window.
Note: Almanac can only set the wallpaper when it is started in normal or 
maximized modes.    Almanac cannot set the wallpaper when it is started minimized as an 
icon. 



If this option is checked, placing the cursor over any button on the toolbar, will display a 
short description of what each button represents.



If this option is checked, Almanac will save the current settings for the active *.ALC file.



Places the Main window into year display mode.



Places the Main window into month display mode.



Places the Main window into day display mode.



Activates the QuickEdit dialog for the current date.



Activates a dialog that prompts for the desired month, day, and year to move to.



Used to move to today.
(Mouse users can double-click anywhere on the surface of Almanac's tool bar to quickly 
reset to today).



These two options are used to set the visibility of items in the To Do window list box.
Select View Pending to limit the list to active items, and optionally only those items which 
have not yet been completed (To Do Item dialog; Activate Date).
Select View All to include all defined items in the list.    Useful for accessing items which are 
not currently active.



Used to add items to the To Do window.    The keyboard equivalent of the To Do window's "+"
tool button.



Used to edit the currently selected item in the To Do window.    The keyboard equivalent of 
double-clicking on an entry in the To Do list box.



Used to mark the currently selected item of the To Do window as completed.    The keyboard 
equivalent of the To Do window's check mark tool button.



Used to archive the currently selected item of the To Do window.    The keyboard equivalent 
of the To Do window's file cabinet tool button.



If any of these selections is unavailable (grayed), the tool window is already active.    It may 
be covered by another window.    In this case you should find the tool window listed on the 
bottom of this menu.    Select this entry to bring the window to the top and/or reactivate a 
minimized tool window.



Positions your tool windows to be displayed simultaneously.



Used to reset the state of Almanac's desktop to that which was last saved in the current 
config file (F10).



Used to enter Almanac Help at the Table of Contents



Used to access Almanac Help by searching keywords.



Use this selection to get Help on Windows Help.



Displays a standard Windows About... dialog for Almanac.



Select View Pending to limit the list to active items, and optionally only those items which 
have not yet been completed.



Print to Metafile (*.WMF)

Almanac can create month and year calendars suitable for pasting into your Windows word 
processor or desktop publishing application.    It does this by "printing" into a Windows 
metafile.    A metafile is a Windows data format that can include both graphics and text.

Almanac must use some device as a guide when creating the output, so that decisions like 
where a line of text should wrap or where to center a title can be calculated.    Almanac uses 
your current target printer when making these calculations.

Most of the settings that are used to control the appearance of printed output may also be 
used when creating metafile output.    The Printer Fonts selected in Options.Fonts dialog 
and the options provided by the File.Page Layout dialog (except header/footer) are used 
when creating month and year metafile images.

Almanac can generate metafile output to either a disk or to the Windows clipboard. 

Output to Clipboard
The clipboard transfer is sometimes a more convenient method to use, however the 
Windows clipboard does not allow an application to pass as much sizing information along 
with the image.    It is up to the receiving application to choose the initial size that the 
metafile is pasted.    

Output to Disk
A disk metafile may produce a different result, although taking a few more steps to save in 
Almanac and then open in another applications.    It's best to experiment and choose the 
method that works best for you.



Export/Import ...

This dialog is accessed from the File.Export/Import Menu.

Overlay

Phonebook

Schedule

ToDo



Calendar Options dialog

This dialog, accessed from the Options.Calendar menu selection, is used to set options for 
the display and operation of the Main window.

Mode
Almanac's internal calendar engine is based upon the modern Gregorian calendar.    This 
combo box is used to choose one of three modes that Almanac can emulate on your 
display and printer.    You can select either the standard Gregorian calendar, the Jewish 
calendar, or a hybrid Gregorian/Jewish format.

Week Begin
Sets the day of the week that appears leftmost in Almanac's calendars.

Red Letter Days
Can be used to cause the numerals of Saturday and/or Sunday to be displayed in red.

Prior/Next Months
Used to control the display of the small calendars in the upper left and right corners of the 
month calendar.

The calendars can be viewed for convenience, or turned off to provide more room for the 
date cells of the calendar.

Notes on month
A pencil symbol will be displayed in a monthly date cell when General Notes have been 
attched to the date.

Time Changes
Transitions from standard time to daylight savings time are marked on the calendar when 
this option is checked.

Moon Phases
Checking this option will display graphics for the four phases of the moon on the month 
calendar display.    The day display also lists the local time of transition for each phase.

Daily Almanac
Checking this option will include sunrise and sunset information (and moon phase data, if 
selected) on the Main window day view.

Daily Julian Day
Selecting Daily Julian Day will display the current Julian date, followed by the number of      
days that are remaining in the current year.    The information appears at the top left 
corner of the Day View, and in the header area of all day binder printouts.

Calendar Week
Selecting Calendar Week will display the current week number based upon the Gregorian 
calendar.    The information appears in the top right corner of the Day View, as well as the 
header area of all day binder printouts.

Jewish Setup...
Selecting Jewish Setup will let you customize the spelling of the individual months.    There 



is an option to display Candelighting and Havdalah.



Scheduler Configuration dialog
See Also Create Schedule Item

This dialog, accessed from the Options.Scheduler menu selection, is used to configure 
options for the Scheduler tool window.

Increment Minutes
Selects the resolution of the time divisions along the left side of the Scheduler window.

The distance between each increment is set to the height of the Tool font.

Summary Bar
The Summary bar appears at the right side of the Scheduler window.    Rectangles mark 
events which occur between its start and end hours.    A dark rectangle half the width of 
the summary bar marks the period currently displayed in the main area of the Scheduler.

Start Hour
The initial hour of the day displayed on the summary bar.

End Hour
The last hour of the day displayed on the summary bar.

Initial Hour
Sets the time that the Scheduler is initially positioned to when a date change occurs.

This time is not used for the current day (today), where the Scheduler will position itself to 
the current hour.

Default Alarm
The number of minutes that the alarm time is initialized before an event.

This is only a default setting, alarms can be adjusted for each event.    The value should be 
zero or negative.





To-Do Configuration dialog
See Also Create ToDo Item

This dialog, accessed from the Options.ToDo menu selection, is used to configure options for 
the To-Do tool window.

Sort Sequence
The To-Do tool list box of items can be sorted in one of two ways:

1) Sorted by priority then by required date (all priority one items appear in ascending 
date sequence followed by all priority two items, etc...).

2) Sorted by required date then by priority (items are listed according to when they are 
due, with higher priority items listed before lower priority items required by the same 
time).

Remove completed items after __ days
Almanac will automatically remove items from the to do list which have been marked as 
completed.    Set the number of days that you wish items to continue appear on your to do 
list after they have been completed.

Archive to-do items removed by Almanac
To do items can optionally be removed from the to do list and recorded to an ASCII text file
(TODO-HST.TXT) when they have been completed, a process called archiving.    Selecting 
this option will archive completed items that Almanac automatically removes from the to 
do list.

View Pending hides completed items.
To help concenrate on overdue or pending items, this selection enables you to view the 
information that is the most important.



Phonebook Options dialog

This dialog is used to configure modem and telephone access information for the auto-dial 
feature offered by the Phonebook tool window.    

Your system must be equipped with a Hayes compatible modem.    The Port and Port Speed 
should be set to the values used by your modem.    Set the Dial type to either tone or pulse 
(rotary dial) according to your local telephone system.

Long Dis.    Access
Enter the digits used to specify a long distance call.    For example, in North American 
countries a '1' is used to dial long distance phone numbers.

Local Area Code
Enter the local area code.    Almanac uses this information to distinguish local phone 
numbers from long distance numbers.    The local area code is only used when 'SmartDial' 
is selected.

Dial Out Prefix
Enter any digits that must be dialed to access an outside telephone line.    Many company 
PBX telephone systems require a '9' to be dialed in front of any outgoing telephone calls.

Default Dialing
Specify this selection to set the Default Dialing action within the Phonebook. Overrides of 
this selection can be specified within the Phonebook entry itself.

(1) Dial Using SmartDial- Almanac examines a telephone number before attempting to 
auto-dial.    If the length is greater than 8 digits, the number is scanned to determine if the 
beginning digits match the Local Area Code.    If so, the call is dialed as a local call by first 
stripping off the area code, and then inserting the Dial Out Prefix, if present.    If the Local 
Area Code search fails, the call is dialed as a long distance call by inserting any Long Dis. 
Access digit(s). 

(2) Dial Numbers Exactly As Entered. 

(3) Preview Numbers Before Dialing.

Data Conversion
Almanac can import or export phonebook data in CSV (comma separated value) format. 
(see File.Import/Export)



 Phonebook Export/Import

Comma Separated Value format refers to an ASCII text file that contains records of 
information.    
If a comma must appear within a field, the entire field is enclosed in quotation marks.    
Commas may be entered without data following them to describe empty fields.

Importing to the Phonebook
Almanac contains a very simple CSV processor.    Almanac allows you to customize the 
Import process, it lets you choose the fields to Import, based on the form of your current 
data.    There are only two REQUIRED fields: (1) CATEGORY and (2) either the LAST NAME
or COMPANY field.    The rest of the fields to Import, is entirely up to you.    
The order of the data, depends on the order you choose in specifying fields to Import.

Exporting from the Phonebook
Select File.Export/Import..., to write the current contents of the phonebook to a CSV    
formatted file. You have the option of which Data Fields you would like to export.    Select 
the field, and push the 'Add' button.    When you have selected the desired fields, push 
the 'Begin Export' button.    Almanac will prompt you to name the *.CSV file, and choose 
the directory to be saved in.



Overlay Export

This dialog is accessed from the File.Export/Import menu selection.
Comma Separated Value format refers to an ASCII text file that contains records of 
information.    

After selecting Overlay.Export, you will be prompted with a date range dialog;    specify 
the range of time.    Upon selecting OK, the 'Field Selection and Ordering' dialog will 
prompt you for the fields you would like to include in the export. When you have selected
the desired fields, push the 'Begin Export' button.    Almanac will prompt you to name the
*.CSV file, and choose the directory to be saved in.

Note: Almanac will only export data in Overlays that are open.



Scheduler Export/Import

This dialog is accessed from the File.Export/Import menu selection.
Comma Separated Value format refers to an ASCII text file that contains records of 
information.    

Importing to the Scheduler
Almanac allows you to customize the Import process, it lets you choose the fields to 
Import, based on the form of your current data.    The order of the data, depends on the 
order you choose in specifying fields to Import. After selecting Schedule.Import, the 
'Field Selection and Ordering' dialog will prompt you for the fields you would like to 
include in the import. When you have selected the desired fields, push the 'Begin Import'
button.    Almanac will prompt you to choose the *.CSV file to import.

NOTE: To have the item appear on the month calendar, enter 1 as the value for the 
Month Display field.    To have it appear only in the Schedule, enter 0 as the value for the 
Month Display field.

Exporting from the Scheduler
After selecting Schedule.Export, you will be prompted with a date range dialog;    
specify the range of time.    Upon selecting OK, the 'Field Selection and Ordering' dialog 
will prompt you for the fields you would like to include in the export. When you have 
selected the desired fields, push the 'Begin Export' button.    Almanac will prompt you to 
name the *.CSV file, and choose the directory where it will be saved.



ToDo Export

This dialog is accessed from the File.Export/Import menu selection.
Comma Separated Value format refers to an ASCII text file that contains records of 
information.    

After selecting ToDo.Export, you will be prompted with a date range dialog;    specify the
range of time.    Upon selecting OK, the 'Field Selection and Ordering' dialog will prompt 
you for the fields you would like to include in the export. When you have selected the 
desired fields, push the 'Begin Export' button.    Almanac will prompt you to name the 
*.CSV file, and choose the directory to be saved in.



Calendar Overlays dialog

This dialog, accessed from the Options.Overlays menu selection, is used to control the 
overlays that display holidays, anniversaries, and other events on the calendar.

Active Overlays
Displays the overlay files which are active for the current config.    This list can be 
maintained using the control buttons located to its right.

Double-clicking on an overlay file appearing in the list is the same as pushing the Edit 
button.

Selection Pathname
This read only edit box displays the drive and directory of the currently selected overlay in 
the Active Overlays list box.

New
Used to create a new overlay file.    The new overlay file is automatically add to the Active 
Overlays list when it is saved.

Open
Used to add an existing overlay file to your current calendar display.    Activates an Open 
File dialog box to select the overlay file.

Edit
Activates the Edit Overlay dialog used to edit the overlay file which is currently selected in 
the Active Overlays list.

Close
Removes the overlay file currently selected in the Active Overlays list from the current 
calendar.

Removing an overlay from the current calendar does not delete the overlay file from disk.

Close All
Closes all overlays from the current config.



Almanac Color Settings dialog

This dialog, accessed from the Options.Colors menu selection, allows customization of the 
colors used to display Almanac on screen.

Basic Colors
Contains a selection of standard colors that can be selected for your current video display.  
Some of the colors are pure and some are blends of two colors.

Select a color by clicking on it with the mouse or position to a color and then press the 
space bar.    The color you select will replace the color of the currently selected Almanac 
display area.    The display areas are shown and selected in the illustrator box located in 
the upper right corner of the dialog.

Screen Area:
Used to select the area of Almanac's display to set the color for.    Mouse users can simply 
click on the area of the display in the illustrator box to set the current selection.

Custom Colors
This control maintains sixteen colors of your own choice.    Colors are selected the same 
way as with the Basic Colors control.    (see Define Custom Colors below for creating new 
colors).

Define Custom Colors
Expands the color dialog, revealing controls used to create or edit custom colors.

Custom color controls
The custom color section contains a full complement of controls for mouse and keyboard 
selections.

The large rainbow control is used to blend the color components using a mouse.    The 
thin luminosity control directly to its right is used to select the intensity of the color.    
Make sure this control is not set to either extreme or you will only be able to create black
and white results.

The Red, Green, and Blue edit boxes below the rainbow control provide another way to 
create colors.    Exact color values for each of the red, green, blue (RGB) components can 
be specified.

The Hue, Sat., and Lum. edit boxes are yet a third way of specifying a color.    These 
values correspond to the HLS color model which represents colors and intensities along a
cone shaped formula.

The Color|Solid control displays the currently mixed color and the closest solid (pure) 
color.    Double-clicking on the solid color will cause the custom controls to re-set to 
define the pure color.

Saving a custom color
Choose the Add Color button to cause the current custom color mix to be saved in one of
the Custom Color boxes.



Almanac Fonts dialog

This dialog, accessed from the Options.Fonts menu selection, is used to change the screen 
and/or printer fonts used by Almanac.    

The screen fonts are selected independently of any printer fonts to allow you to choose 
those best suited for each purpose.

Set Fonts For:
Select either Printer or Display to place the dialog into the desired mode.

Text areas:
Contains entries for the various areas that Almanac can use a different font.    The areas 
each one affects are:

Month and Year Titles (Display)
On month calendars, this is the current month and year centered near the top of the 
calendar.    For year calendars, this is the year displayed above the calendar area.

Month Days and Dates (Display)
This selection includes the day of week headings and date numerals which appear in 
month calendar displays.

Month Event Text (Display)
The text within the date cells of the month display.    Overlay events and schedule 
information are displayed in this area.

Mini Calendars (Last/Next and Year) (Display)
Used for the body of the year calendar display, as well as the prior and next months on 
the month display.

Day Calendar (Display)
This is the font used for the day view calendar display of the Main window.

Almanac will automatically create a bold version of this font to distinguish headings on 
the day view.

Tool Windows (Display)
The font selected for tools is used by all of Almanac's tool windows - the Scheduler, 
Notes, and To-Do list.

Almanac will automatically create a bold version of this font to distinguish headings 
where appropriate.

Printer Fonts
The printer font selections are used almost identically to those for the display.    There are
two exceptions:

(1) Two fonts areas are provided to allow different settings for the body of the year 
calendar, and for the prior/next months in the month calendar.

(2) An additional area called Title is available to select the font used for printing a title as



a headers or footer.



Icon Clock dialog

This dialog, accessed from the Options.Icon Clock menu selection, is used to select the 
option of displaying Almanac as a desktop clock when the program is minimized, instead of 
an icon.    The desktop clock may be placed anywhere on the screen.

Display clock when minimized
Checking this box will cause Almanac to minimize to a desktop clock, and will enable the 
remaining controls in the dialog.

Removing the check will cause Almanac to minimize to a standard desktop icon and will 
disable the Iconic Clock controls.

Always on top
Selecting this option will cause Almanac's desktop clock icon to remain on top of any other
regular desktop windows.    (Windows 3.1.)

Display time (date, day of week)
The last three check boxes in the Iconic Clock section request Almanac to display time, 
date, and/or the day of the week in the desktop clock.    At least one of these items must 
be selected.



Almanac Sound Setup dialog

This option, accessed from the Options.Sound menu selection, is made available if Almanac 
detects the presence of Multi-Media sound extensions in your Windows configuration.    

It is used to associate digital sound files (*.WAV) with Almanac audible alarms.

Alarm
Contains entries for eight different audible alarms.    Almanac has four internal alarms that 
it can sound.    These internal alarms are used in the absence of multimedia sound.    The 
internal alarms used for alarms one through four are repeated for alarms five through 
eight.

Select the alarm you wish to associate with a digital sound file from this list box.

Test
Plays the currently selected alarm.

Description
Used to attach a description of the alarm.    It will appear in the Scheduler dialog alarm 
combo box.

Possible uses can be to describe the recorded sound (Cuckoo clock) or to describe the type
of event it is used for (Coffee Break).

Sound File
The file name of the digital sound file.    It will contain "None" if the alarm has no external 
file association.

Set File
Displays a file open dialog to allow the selection of a sound file.

Internal
Clears any current sound file association with the alarm (Sound File set to "None").



Customizing the Location Database

This option, accessed from the Options.Location menu selection . Choose this command to 
set the location that Almanac uses to calculate sunrise-sunset, moon phases, and the 
display of data that has a time attached.

    
Point-of-Reference Location

Select any location to use as a point of reference.    All times computed and displayed by 
Almanac will be adjusted to local time of the point of reference location.

    
System Location

Almanac needs to know the correct time zone of your computer's clock.    This information 
is required to properly calculate times and dates for any point of reference location around 
the world.

    
New Location

Select 'Point-of-Reference' to enter a new location into Almanac.    Put in the proper 
degrees, minutes, and seconds for latitude and longitude. You may obtain local coordinates
from your city hall, library, or local airport.

Current Users
If you have already entered a customized location in a previous version of Almanac 
(filename:ALMLOCN.DAT), you may obtain proper coordinates from this file.    You may 
open this file with Microsoft NOTEPAD, or any ASCII text editor.    The latitude for the 
location is the first set of three numbers, and the longitude is the second set.



Almanac Desktop

Almanac uses the Windows Multiple Document Interface (MDI).    The Main document window
is used to display the calendar.    

Five additional "tool" document windows are available: a notepad, a scheduler, a to-do list, a
phonebook, and a search window.

The Main window displays calendar information according to the current display mode, 
identified by one of the three calendar mode buttons on the tool bar.    Year, month, and day 
view modes can be selected by clicking on the appropriate tool button or by making a 
selection from the Window menu.

The five tool windows can be activated by either clicking on the appropriate tool bar button, 
or by selection from the Window menu.

Arranging the desktop
Almanac's desktop can be customized to suit individual preferences.    The desktop state can 
then be stored in a calendar file by selecting File.Save or File.Save As... to preserve the 
arrangement.    You can select Window.Reset Desk or click on the reset tool button (located 
at far right on tool bar) to automatically reset to this default arrangement during an Almanac
session.

A discussion of window settings, fonts, and colors follows.    All of these items can be 
configured and saved within a calendar file.

Window Arrangments
The windows which are currently active, their positions, sizes, and states (normal, iconic, 
maximized), are all written to the calendar file when it is saved.

You should position and size the windows to best complement your own use of Almanac.

Save the calendar file using File.Save whenever you would like to reset your default desktop 
to the current configuration.

Display Fonts
Select Options/Fonts... to change the display fonts.    Save the calendar file to make the new 
settings permanent.

Colors
You can change the color of the calendar grid, the highlight rectangle, as well as the theme 
color and shadow used to accent the document windows.    Select Options.Colors... to change
the color configuration.



Desktop Clock

Almanac can be minimized to a clock instead of the normal desktop icon.    The clock 
displays the current time, date, and/or day of week.    To configure the minimized desktop 
clock, select Icon Clock... from the Options menu to activate the Almanac Icon dialog.

A small horizontal window is displayed in the bottom right corner of the screen when 
Almanac is minimized and this option is first selected.    You can position the clock anywhere 
on the desktop that you would like.    Drag the window with the left mouse button, or select 
Move from Almanac's system menu (Alt-Space) and reposition the window using the 
keyboard arrows.





        Notes Tool Window 
This window is used to attach text to a date, a to-do item, an appointment, or a 
phone/address entry.    Invoke this window from the Window menu (F8).

The Notes window will display a note page for each type of event as it is highlighted, and 
recall any existing text for that event.    A General Notes page will display for the selected 
day when the Main window is active in the month or day modes.    Pages will appear in the 
Notes window for the selected item, for the active tool window.

Enter information into the window as you would in any other Windows text area.    Almanac's 
Edit menu provides all of the standard Windows clipboard controls, including an Undo 
command.

Any text entered into the Notes window is automatically saved to disk when you move focus 
to another window on your desktop.



General Notes
General Notes are maintained by Almanac for every date.    This area can be used to 
maintain a diary or any other type of information that you would like to track by day.





Overlay Files
See Also Overlay Event Dialog and Pre-defined overlays

Overlay files are used to display information related to calendar dates.    Common examples 
are holidays, birthdays, anniversaries, etc...

You can create or edit an overlay file by selecting Overlays... from the Options menu.    
Individual overlay entries can also be added or modified through the QuickEdit dialog.

Managing Overlay Files
Definitions for one or more events are stored in each overlay file.    Different types of events 
can be placed into different overlay files to assist in organizing the information.

Up to fifteen overlay files may be specified in a config file.    This allows you to mix and 
match the types of events that are required for any calendar need.    A little bit of 
forethought about how to best divide your information among overlays will make using 
Almanac easier and more productive.

For example, you may decide to include the birthdays of your relatives into one overlay file, 
while placing friends' birthdays into another.    The more specifically you define the 
categories of your overlay files, the more control and flexibility you will have creating config 
files.



Pre-defined overlays

 

Your Almanac package includes several overlay files that define many standard holidays.    
For example, the file USA_HDAY.ALO contains the most common holidays observed in the 
U.S.      The CHRSTIAN.ALO and JEWISH.ALO files include definitions for holidays observed by 
many Christian and Jewish users.    You can select these and/or other overlay files of pre-
defined events by choosing the Open command from the Options.Overlays dialog.

The overlay files that come with Almanac are not hardcoded tables of information.    
They are simply example files that have been created to save you time and demonstrate 
how overlay files can be used.    You can edit these overlays to meet your own needs.



QuickEdit dialog
The QuickEdit dialog is accessed by double clicking in the Main window date cells, or by 
selecting QuickEdit... from the Main menu.

The dialog displays a list box containing overlay items and/or scheduled items for editing.
Make a selection and choose OK to activate either the Overlay Event or Schedule Item    
dialogs.

Double-clicking on text within the month date cell, will go directly to the Edit Overlay Event 
dialog, or a Modify Schedule Item dialog.    If a date cell contains more text than it can 
display, by expanding the cell (Shift Key), the same functionality is available. Click the right 
mouse button, within a date cell, for a popup menu.    A convenient way to expand the cell, 
switch to the Day View, or start a QuickEdit session.



Overlay Event dialog
Used to add or modify overlay entries.

Save In
This combo box control is only available when adding a new overlay entry.    Select the 
active overlay file that you wish the event to be saved in.

Text
Up to forty characters of text describing the event.    Some overlay item types require 
specific information.    Birthdays and anniversaries require the name of the person(s) in this
control.

Start/End
This check box is used to request start and end dates for a new event.    It can also be used
to limit which occurrences a change will be applied to, for an existing event.

Occurs On:
Used to enter the date, or starting date for the overlay definition. This control has a drop-
down operation to allow enhanced mouse and keyboard selection of dates. The control can
be opened and closed with the normal drop-down commands of Alt-Down Arrow and Alt-Up
Arrow, or the mouse can be clicked on the control's arrow button.

Recurring:
This combo box is filled with event types based on the date entered into the Occurs On 
control described above.    Changing the Occurs On date will change the items in the 
combo box.

Some types of recurring events require additional information.    If you select one of these 
types, such as "Every n days," a push button will appear directly to the right of the combo 
box that is user to enter the extra information.

End Date
Only available when the Start/End check box is checked.    Any additions or changes 
entered will be limited up to and including this date.

Calendar Accents
Used to activate the Color Accents dialog to highlight an event on the monthly calendar.

Time: (optional)
Used to set a time for the overlay event.    Once establishing a time, the Time Zone button 
will become active, so that you may specify a time zone different than the one set through 
Options.Location.    It may prove invaluable to users who have to keep track of different 
meetings/events that do not occur locally; or users who travel extensively.

Note:    Setting a time for an overlay event will not activate an alarm.    To set an alarm for 
an event, you must enter it as a Schedule Item, through QuickEdit or    the Scheduler 
window.

Listing Priority
You may assign a value between 1-999, to specify the most important events for the day.    
This will enable you to determine the order Overlay events appear on your monthly 
calendar.    If no priority is set, it will default to a priority '999' listing.    If a time is attached



to the event, you may assign a value between 1-255, it will default to a priority'255' if no 
priority is set.



Color Accents dialog
See AlsoColors Settings

The Color Accents dialog is accessible at both the overlay and the overlay item levels.    
Choose "Default Accent..." from the Edit Overlay dialog to define a global accent setting that
applies to all entries in the overlay file. Choose "Accents..." from the Edit Overlay Event 
dialog to set an accent for an individual overlay item and override any existing global 
accent.

You may include the accents on the month calendar printout (see File.Page Layout).    

The following controls are located in the group box in the upper right corner of the dialog.

Accent Type
The Pattern selection is always available.    Select Pattern to fill the background of the 
monthly date cell with a solid or pattern color.

The Symbol selection is available for Windows installations which support TrueType fonts.   
Select Symbol to display a TrueType character in the date cell.

Pattern / Symbol
The combo box located directly above Accent Type contains the names of patterns or 
symbols that will display in the monthly date cell.    The choice will be displayed in the date
cell in the selected color.

Color Text
Displays the text of the event in the selected color.

Red Letter
Displays the numerals of any date this event falls on in red.

See the    dialog to learn more about the operation of the standard color controls.



Jewish Calendar Features

Almanac's internal calendar engine is based upon the modern Gregorian calendar.    It can 
also calulate and display information based upon the Jewish calendar.    The calendar display 
mode can be set to Gregorian, Jewish, or mixed-mode by selecting Options.Calendar... from 
Almanac's main menu.    Overlay events can optionally be defined based upon a Jewish 
calendar date.

(see Calendar Optionsdialog and Jewish Holidays for more information).



Jewish Holidays
Holidays based on the Jewish calendar can be defined in either Gregorian or Jewish display 
mode.    Almanac will also calculate birthdays and yahrzeits based upon the Jewish 
calendar.    These dates are entered and displayed using the Jewish calendar date.

TIP: If you know the Gregorian date of an event, Almanac will automatically calculate the 
Jewish date for you.    Enter the Gregorian date when defining the event, then choose the 
appropriate Jewish-based event type.      See Overlay Files for more information on how to 
define overlay events.



Yahrzeits: Special Cases

Special guidelines must be followed when determining the future dates to observe Yahrzeit 
when the original date of death occurred on the 30th day of Cheshvan or Kislev, or in a 
month of Adar.    Often, the guidelines that are followed to determine these dates for Yahrzeit
differ from the those used for other types of anniversaries. (See, "Birthdays and 
Anniversaries").

Numerous opinions on the dates of future observances of Yahrzeit, (See, "Yahrzeits"), were 
found while researching this area.    The following jump topics can be used to review the 
variations that Almanac attempts to support in the interest of providing a non-partisan tool 
for all users.    The more widely accepted variations are noted, as well as the less common.    
We encourage each user to consult their Rabbi to determine which rules to follow.

The rules that are enumerated in the following jump topics were compiled solely from 
rabbinical sources.    For a bibliography of these sources, please see, "Yahrzeit: Reference 
Bibliography."

Click on any of the following jump topics for more information.

Original date of passing:

1. In the month of Adar. (non-leap year)
2. On the 30th of Adar I. (leap year)
3. In the month of Adar I or Adar II. (leap year)
4. On the 30th day of Cheshvan or Kislev.



Birthdays and Anniversaries

Anniversaries are observed each year on the same month and date of the Jewish calendar.    
A person's birthday and the observance of Yahrzeit, (please see "Yahrzeits"), are two 
examples of anniversaries.

In some cases, the month and date of the original event does not appear in every year of 
the Jewish calendar.    This occurs because the Jewish calendar rotates through a nineteen 
year cycle that includes the addition of an extra leap month in some years, and two months 
whose length varies between 29 or 30 days.    The following rules apply to the method that 
Almanac uses to calculate anniversaries that fall on these dates.

Adar Anniversaries

1) The anniversary of a date that occurs in the month of Adar in a non-leap year is 
observed on the same date in the month of Adar II in a leap year.    For Yahrzeit exceptions,
please see, "Yahrzeits: Special Cases".

2) The anniversary of a date in the month of Adar I in a leap year is observed on the same 
date in the month of Adar in a non-leap year.    If the original date was 30 Adar I, then the 
anniversary is observed on the 1st of Nisan in a non-leap year.    For Yahrzeit exceptions, 
please see, "Yahrzeits: Special Cases".

3) The anniversary of a date in Adar II of a leap year is observed on the same date of Adar 
in a non-leap year.

30 Cheshvan and 30 Kislev

If the original date occurred on the 30th of either of these months, then the anniversary is 
observed on the first of the following month for those years when the month has only 29 
days.    Therefore a person born on 30 Cheshvan would obseve their birthday on Kislev 1 in 
years when Cheshvan has only 29 days.    For Yahrzeit exceptions, please see, " Yahrzeit on 
30 Cheshvan or 30 Kislev".



Yahrzeits

Yahrzeit is an annual observance that occurs on the anniversary date of the death of a 
parent, grandparent, or other close relative.

The date of Yahrzeit usually occurs on the same month and date each year.    In some cases, 
the month and date of the original event does not appear in every year of the Jewish 
calendar.    When this happens, the anniversary is observed on a different date, the same as 
other anniversaries that are tied to the Jewish calendar, (please see "Birthdays and 
Anniversaries").    This occurs when the original date of passing is on the 30th day of 
Cheshvan or Kislev, and for many dates in the months of Adar, Adar I, and Adar II..    

Calculating future dates to observe Yahrzeit for these special cases presents a special 
problem for Almanac.    Unlike other types of anniversaries, there are numerous opinions as 
the rules to follow when determining future dates to observe Yahrzeit.    For this reason, 
Almanac will invoke a dialog that asks the user to confirm the dates for future observance of 
Yahrzeit when it detects the entry of a date that falls into any of the above categories.

Examples of varying rules for these adjustments are included in, "Yahrzeits: Special Cases."   
You should consult your Rabbi if you are unsure of the rules to follow.    It is important to be 
consistent in one's customs.    These examples are only provided to illustrate the variation in 
practice.



Yahrzeit for Adar
See Also: Yahrzeit: Reference Bibliography
See Also: Yahrzeit: Special Cases

When a person passes in the month of Adar in a non-leap year, some references indicate 
that Yahrzeit should be observed in Adar I, some say Adar II, while others suggest observing 
Yahrzeit in both months in a leap year.

-    "In subsequent leap years, the custom varies.    Some establish the yahrzeit date in the 
first Adar, and others in both Adars.    One should be consistent in one's custom." [1]

-    "In a leap year the first Adar has thirty days and the second has twenty-nine.    The first 
Adar is considered the extra month, not the second.    That is why the second has the 
number of days of a regular Adar.    Purim is celebrated in the second Adar, and so are 
birthdays and yahrzeits that occurred in a regular Adar." [2]

-    "In leap years, Yahrzeit is always observed in Adar II regardless of whether the actual day 
of death was in Adar I or Adar " [3]

Almanac provides the opportunity to select either Adar I or Adar II in this situation.    Users 
who choose to observe Yahrzeit in both months of Adar in a leap year should enter two 
separate entries for the Yahrzeit and assign each one a different month of Adar for the leap 
year observation.    Using this method will produce the side effect of a "duplicate" display in 
the month of Adar in a non-leap year.



Yahrzeit for 30 Adar I
See Also: Yahrzeit: Reference Bibliography
See Also: Yahrzeit: Special Cases

When the original date of passing occurs on 30 Adar I, some customs support the 
observance of Yahrzeit on 1 Nisan in a non-leap year.    Others observe Yahrzeit on 29 Adar in
a non-leap year.

Anniversaries for this date (other than Yahrzeit) are normally observed on 1 Nisan in a non-
leap year.    The anniversary date of 29 Adar in a non-leap year is a special custom that only 
applies to the observance of Yahrzeit.



Yahrzeit in Adar I or Adar II
See Also: Yahrzeit: Reference Bibliography
See Also: Yahrzeit: Special Cases

When the original date of passing occurs in either the month of Adar I or Adar II, the 
prevailing custom, by far, is that future Yahrzeit observances will be on the same date and 
month in a leap year, and on the same date in Adar of a non-leap year. (Special case, see, 
"Yahrzeit for 30 Adar I")

One reference has been found that describes the custom of observing all Adar yahrzeit dates
in the month of Adar II.

-    "The yahrzeit date will subsequently be the day and month of passing - in a leap year on 
the appropriate Adar, and in the only Adar of a regular year." [1]

-    "In leap years, Yahrzeit is always observed in Adar II regardless of whether the actual day 
of death was in Adar I or Adar " [3]



Yahrzeit on 30 Cheshvan or 30 Kislev
See Also: Reference Bibliography
See Also: Yahrzeits: Special Cases

Several customs have been found for observing Yahrzeit in future when the original date of 
passing occurs on 30 Cheshvan or 30 Kislev.    The standard rule that is used in future years 
when the anniversary month has only 29 days is to observe the anniversary on the 1st of 
the following month.    In this case, for a death that originally occurred on 30 Kislev, future 
observances of Yahrzeit would be on 30 Kislev in years that Kislev has 30 days, and on 1 
Tevet in years when Kislev has only 29 days.

Other customs calculate the dates of future observances of Yahrzeit based on the number of 
days in the month that the first anniversary occurs in.

In one example, if the original date of death is Kislev 30, and in the following year Kislev has 
30 days, then Yahrzeit is observed on the 1st of Tevet in this and all subsequent years that 
Kislev only has 29 days.    If, however, Kislev contains only 29 days in the first anniversary 
year, then Yahrzeit is observed on 29 Kislev in all years containing only 29 days.    In this 
custom, Yahrzeit is always observed on the original date (30 Kislev) in those years that the 
anniversary month contains 30 days.

Another custom supports a simlar determination of future dates based on the first 
anniversary month.    In this case, however, if the month of the first anniversary contains 
only 29 days, then Yahrzeit is observed on the 29th day of the month in this and in ALL 
future years.



Yahrzeit: Reference Bibliography
See Also: Yahrzeits: Special Cases
See Also: Yahrzeits
See Also: Birthdays and Anniversaries
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        Phonebook Tool Window
This window is used to maintain addresses and phone numbers.

Invoke the Phonebook window by clicking on the Phonebook tool window or by selecting 
Phonebook (F7) from the Window menu.    An auto-dial function is available in the Phonebook
tool window.    It must first be configured from the Options menu (see Options/Phonebook).

Using the Phonebook window
To enter an address/phone number, select the New button in the Phonebook window.    This 
will invoke the New Phone/Address Entry dialog box.    All fields that have a drop-down arrow 
box, will eventually contain a customized glossary, created by you.    As you enter more 
names and addresss into the phonebook, the process becomes much easier, as you have 
built up a set of terms to be easily referenced with the drop-down arrow boxes.

The Category field must be specified when a new record is entered into the phonebook.    
Also, either the Last Name or Company field must be specified.    All other fields may be used
as required.

Category
Entries into the Phonebook are classified by this field.    When viewing entries in the 
Phonebook window, the Category combo box can be used to limit access to a selected 
category of entries, or can be set to "All" to view your entire phonebook.

Almanac can display phonebook entries either by Individuals or Organizations (companies).   
Selecting "Individuals" will display all entries that have information in the Last Name field.    
Selecting "Organizations" will limit the Name list to entries which include a name in the 
Company field.

Quick Find
Upon opening the Phonebook, the 'Name' field is highlighted (active).    You can display a 
desired entry, in the selected Category, without dropping the combo box.    Start typing the 
letters of a Last Name, or Company Name of an Individual/Organization.    With each letter, 
the parameters of the alphabetical search narrow. The feature has a 2 second delay, after 
that, with each new letter it will start at a new location, alphabetically in the list.      



Editing a Phonebook Entry
You may edit an entry within the Phonebook, by first selecting the entry, then click the Edit 
button.    Make any desired changes to the Phonebook entry, then select OK.



 Navigating within Almanac
Also See Almanac's Desktop

Almanac is designed to provide a flexible system for managing information that is related to 
time.

Almanac's tool windows are linked internally, and will attempt to provide additional 
information for the currently active item whenever possible.    The Scheduler and Notes 
windows will "snap" to the selected date in the Main window.    Similarly, the Notes window 
will provide pages for general notes, scheduled items, to do items, or a phonebook entry, 
depending on the window that is currently active.

You can move from one window to another by:
» Clicking on the window's tool button.
» Clicking on the new window with the mouse.
» Pressing Ctrl-Tab.
» Using the Window menu.
» Using the function keys that are assigned to each tool window (see Keyboard Tips).

Although Almanac provides the capability to minimize any of its windows to icons, the tool 
ribbon buttons provide the quickest access to a tool window no matter what its current state.
They will take the appropriate action to create, activate, and/or restore a window to the 
display.





The Main window
See Also Keyboard Tips

Almanac's Main window provides all of the calendar functions of the program.    It can be 
displayed normal, maximized or minimized (as an icon) within Almanac's frame window, but 
it does not close until Almanac terminates.

The Main window can display several calendar views.    Select the year, month, or day view 
by clicking on the appropriate tool button or by using the Main menu.

Working in the Main window

 The following actions can be taken with the mouse in the Main window:

Month view
» Click the right mouse button, within a date cell, for a popup menu.    A convenient way to 

expand the cell, switch to the Day View, or start a QuickEdit session.
» Click on any date cell to make it the active date.    If active, the Scheduler and Notes 

windows will snap to the date.
» Double-click over the date numerals of a date cell and the Main window moves to the 

day view for the selected date (same as clicking on day and then on day view tool 
button).

» Double-click anywhere else in the date cell to activate a QuickEdit dialog box for 
updating overlays and schedules.

» Double-click on the previous or next month calendar to move to that month.
» Double-click on the year to move to the year view.

Year view
» Double-click on any month in the year view to move to the month view.

Day view
» Double-click in the date area to enter or edit an overlay item.
» Double-click on any item in the Schedule area to edit it, or on the last (vacant) line to 

enter a new item to the schedule.
» Double-click on any item in the ToDo area to edit it, or on the last (vacant) line to enter a 

new item due on the selected date.
The daily view has the concept of a moving "focus" to allow keyboard access and enhanced 
mouse functionality through the individual items appearing on the day calendar.    An 
inverted 
highlight indicates the current area that has the input focus.    The keyboard up and down 
arrows, 
will move through the items on the calendar.    Pressing the Space Bar will cause a selection 
to occur as if the mouse were double-clicked.    Dialogs will be presented for overlay items, 
schedule items, or to-do items depending on the area that is currently highlighted.    
Highlight the line containing the date to enter a new overlay item.



     The keyboard can also be used for actions in the Main window:

Month view
» Use the cursor arrow keys to select a date cell.    The Home key moves to the first of the 

month and the End key moves to the last.
» Select Day View from the Main menu to change to day mode.
» Use the PgUp and PgDn keys to move to the previous or next month.
» Select Year View from the Main menu to move to the year mode.

Year view
» The cursor keys work as for month mode.    PgUp and PgDn move to the next or last year.
» Pressing Enter while in the year view will move to the month mode for the currently 

selected month.

Expanding a date cell
Press the Shift key when Almanac's Main window is in the month mode to expand a date cell.
The cell will expand to about four times normal size, revealing information that was not 
visible in the smaller cell. Double-clicking on text within the month date cell, will go directly 
to the Edit Overlay Event dialog, or a Modify Schedule Item dialog.



Running Almanac as an Icon

Almanac provides two special features when it is minimized to an icon.    It can display the 
custom icon and description that you have defined in Program Manager, or it can display a 
digital clock in the lower right corner of your display, and then be moved anywhere on the 
screen.

Custom Icon and Description
Minimizing to a custom icon requires Windows 3.1 Program Manager or a Win 3.1 
compatible shell program.    This option is invoked by specifying a config filename to 
Almanac on its command line.    When Almanac is started in this manner, it will load the 
config file and attempt to acquire a text description and icon from the Windows shell 
program.    If successful, the new icon and description will be used when Almanac is 
minimized until a File.Open or File.Save As... command is performed.

Iconic Clock
Almanac can be configured to minimize to a digital clock in the lower right corner of your 
display instead of a desktop icon, you may then move the clock anywhere on the screen.    
Select Options.Icon Clock... to access the Almanac Icon dialog.



Printing with Almanac
See Also Fonts

Almanac will print the currently active window.    

Page Layout Settings
The Page Layout dialog allows access to print settings based upon the currently active 
window.    For example, to change the page layout settings for a year printout, first make 
sure that the Main window is the active window (its title bar is highlighted) and that it is 
currently displaying in year view mode.    Then access the Page Layout dialog by selecting 
File.Page Layout.

Almanac allows you to set the margins and paper orientation for each printout format.    A 
page header or footer can also be specified.    The following control codes can be used when 
entering the text of the header/footer.    Almanac will insert the actual values for these codes
when documents are printed.

Code Used For
&d Short Date
&D Long Date
&t Time of Day
&p Page Number

Two check box controls are available when defining the page layout for the month calendar.   
Select the "Size to margins" option to override the normal height-to-width proportion used 
for month calendars.    Select "Accent Patterns" option to include accents on monthly 
calendar printouts.

Sending Output to the Printer
The File.Print... dialog is used to request Almanac to send information to your printer.    Like 
the Page Layout dialog, this dialog reacts to the currently active window.    To print a month 
calendar, first make sure the Main window window's title bar is highlighted and the Main 
window is in the month view mode.    
NOTE: If using a black and white printer, you may turn off the accent shading on the 
printout, from the File.Print dialog (default setting to print accents).

The print dialog will allow the selection of a time range appropriate for the type of print 
being produced.

When printing a Day Calendar, an additional group box is displayed on the Print Day 
Calendar dialog that allows a choice of a standard list formatted printout or a printout 
formatted for use with day organizer binders.    When the Day Binder type is selected, you 
can choose from several different day binder layouts by choosing the "Layout..." pushbutton.
(see Day Binder Printing)

Some printer settings such as print quality and number of copies can be specified on this 
dialog.    All other print settings are accessible by selecting the Setup pushbutton.

Choosing a Printer or Changing Printer Settings
Select File.Printer Setup... to select a different printer or different print settings than your 
Windows default printer.    Note that Almanac will ignore the paper orientation of the selected
printer and use the orientation that was specified in the File.Page Layout... dialog.





Print the Day Binder

Almanac can produce day binder printouts in a variety of sizes.    The formats are based and 
printed on the "Letter" and "A4" paper sizes.

Three different print formats are available for each paper size.

1.    Full page portrait

2.    Half page landscape, one day per page

3.    Half page landscape, two days per page

In North America, the landscape formats can be used to print directly to Laser Organizer 
Pages available from Avery (the label folks).    The Avery part number is 41357.

Printer Limitations
Not all printers can print as close to the edge of the paper as others.    The dual landscape 
format likes to print about 3/10 of an inch up to the right edge of the paper.    Most laser 
printers are able to print even closer than this, but some printers cannot.    Almanac will 
decrease the width of its output to print within the printable area of a printer.

NOTE: At the time of release, the latest printer driver available for the HP Deskjet 500 series
reports a larger printable area to programs than the printer driver will print on the page.    
Users who choose the dual landscape mode and print to a DJ 500 printer will have the right 
edge of the second day print missing until HP corrects this error.    Using the single landscape
format is the only workaround currently available.



         Frequently Asked Questions
See Also Keyboard Tips
See also Foreign Language Capability

Following are the most common questions about Almanac.    Scan this list before you call 
Impact Software's Technical Support Team-you may save yourself a phone call.

Each question is followed by the word ANSWER.    To see the answer, click ANSWER.

1.    How can I save independent config files? When I select File.Save As, and save it, 
Almanac displays        
          the same information. ANSWER

2.    I have set my Wallpaper to display Almanac's Main window, how do I change it back to 
the
          previous Wallpaper? ANSWER

3.    I have entered a Schedule Item, how can I get it to appear on the month calendar?    
ANSWER

4.    How can I get text to appear on the month calendar? ANSWER

5.    I tried to use the auto-dial feature in the Phonebook, but it will not dial the right 
number?
        ANSWER

6.    Why does the text appearing on the screen of the month calendar, not show up on the 
printout?
          ANSWER

7.    Can I import information from another application into Almanac? ANSWER

8.    Can I export information from Almanac, into another application? ANSWER

9.    Can I insert a date/time stamp on the printout of the month calendar?    ANSWER



Resetting Wallpaper

 

If running Program Manager as your Shell Program, then you must open up Control 
Panel.Desktop. Use the drop-down combo box to chose a new file for your Wallpaper, select 
OK.

Note:    If the Wallpaper reverts back to Almanac, after you have made the change, select 
Options.Wallpaper, and make sure you do not have Almanac setting the wallpaper upon 
StartUp.



Month display of Schedule item

 

Open the Scheduler, and double-click on the item.    In the Edit Shedule Item dialog, there is 
a Month Display box, click this box, and select OK.    Your Schedule Item will display on the 
month.    It will display all new Schedule Items on the month calendar, until you un-check this
option.



Text on the screen

 

You may display text on the month calendar, two ways: 
(1) Opening an existing Overlay file; creating a New Overlay file, or 
(2) Creating a New Schedule Item, and within that dialog, selecting Month Display.    See 
Overlay FilesandScheduler Tool Window



Auto-dial

 

The first step is to confirm that you have set the Modem configuration, found in 
Options.Phonebook.    Within that dialog,    set the Default Dialing, if the default setting does 
not work with particular numbers, you may override this setting in the Phonebook entry 
itself (Dial Action).



Month printout

 

Each config file contains two sets of Fonts.    One for the display, and the second, to send to 
the printer (set in Options.Fonts).    You will be able to get more text on the printout by down 
sizing your printer Font, by expanding your margins (set in File.Page Layout), or a 
combination of both.



Importing information

 

You may Import Phonebook, and Scheduler data only.    This option is found in 
File.Export/Import. Almanac accepts data in a CSV (comma separated value) format.      



Exporting information

 

You may Export selected information.    This option is found in File.Export/Import. Almanac 
converts data into a CSV (comma separated value) format.    



Date/Time Stamp for Month Printouts

 

You may insert the date, time, or page number through the File.Page Layout.Header/Footer 
dialog.

1) Long date - &D
2) Short date - &d
3) Time - &t
4) Page - &p



    Keyboard Tips
Tool Windows (Main Menu)

    »Calendar (F4)
    »Schedule (F5)
    »To-do (F6)
    »Phonebook (F7)
    »Notes (F8)    Insert time/date stamp with Shift+F5.
    »Search (F9)
    »Reset Desk (F10)

Year View
    »Pressing the Space Bar, will switch to the Month View, of the highlighted cell.

Month View
    »    Use the cursor arrow keys to select a date cell. The Home key moves to the first of 
the 

month and the End key moves to the last.
 

    »    Use the PgUp and PgDn keys to move to the previous or next month.
    

    »    Press the Shift key when Almanac's Main window is in the month mode to expand a 
date cell.    

The cell will expand to about four times normal size, revealing information that was 
not visible 

in the smaller cell.

    »Pressing the Space bar, will switch to the Day View of the highlighted cell.

Day View...
    »    The day view has the concept of a moving "focus" to allow keyboard access and 
enhanced 

mouse functionality through the individual items appearing on the day calendar. 

    »    An inverted highlight indicates the current area that has the input focus.    

    »    The keyboard up and down arrows, will move through the items on the calendar.    

    »    Pressing the Space Bar will cause a selection to occur as if the mouse were double-
clicked. 

Dialogs will be presented for overlay items, schedule items, or to-do items depending
on the 

area that is currently highlighted.    

    »Highlight the line containing the date to enter a new overlay item.



Foreign Language Capability

New Users
Although it is not currently possible for us to create and distribute Almanac in different 
languages, it is important to try to meet the needs of the many customers who would enjoy 
such a capability.    

Almanac 3.5 has been designed with the option of customizing the text that appears on the 
menu as well as the text of calendar displays and printouts.

Almanac 3.5 will look for the file ALMSTR.TXT in the directory that it is executed from.    This 
file contains the foreign language equivalents for specific text that is used in Almanacs 
menus and displays.

If your Windows installation is configured for either the French, German, or Spanish 
language, Almanacs SETUP utility will ask you if you would like it to install the appropriate 
language information for you.

Current Users (French, German, or Spanish)
With this new version we have added new menu, and calendar content items. If prompted 
upon SETUP, that your ALMSTR.TXT file is out of date; with Almanac not running, please 
run SETUP again.    When prompted please select 'Yes' to install new ALMSTR.TXT, to update 
new menu, and calendar content items.

Current Users (Other Languages)
With this new version we have added new menu, and calendar content items. The file which 
you may use as the template is ALMENG.TXT.    View this file and add the appropriate 
additions to your working file-ALMSTR.TXT.



      Scheduler Tool Window
See Also Create Schedule Item

This window is used to maintain appointments or to partition time throughout the day.    
Invoke this window from the Window menu (F5).

Time is depicted vertically in both the main area and the summary bar on the right.    Tick 
marks to the left of each indicate the time.    The summary bar displays time across the 
entire day.    The start and end times of the summary bar are configured from Options menu 
(see Options/Scheduler...).    A colored rectangle on the summary illustrates the time period 
which is currently displayed in the main area.

Using the Scheduler window
The main area of the Scheduler can be used to enter and update items.    To enter an event, 
position the mouse cursor in the main area next to the desired start time for the item.    
Press the left mouse button, and the start time will display in the title area of the Scheduler.  
If you need to adjust the start time, first release the left mouse button and then move the 
cursor either up or down.

To schedule an event at the start time displayed, hold the left mouse button down while 
dragging the cursor down the Scheduler.    Release the mouse button when you reach the 
desired end time.    This will activate the Add Schedule Item dialog.

Updating an Appointment
Double-click on any event in the Scheduler window to recall the information for changes.    
See Changing a Scheduled Item.



    Create Schedule Item
See Also Changing a Scheduled Item 

 

Description
Up to forty characters of text describing the appointment or time entry.

Occurs:
The date of the event.    For recurring events, the first date that the other dialog 
parameters apply to.

Recurs:
This combo box is used to select a recurring event type.    An entry is included for every 
type of recurring event that can be scheduled based on the Occurs date.

Start/End Time
Used to change the start and end times of the event.    This control has a drop-down 
operation to allow enhanced mouse and keyboard selection of times. The control can be 
opened and closed with the normal drop-down commands of Alt-Down Arrow and Alt-Up 
Arrow, or the mouse can be clicked on the control's arrow button.

Time Zone
You may specify a time zone different than the one set through Options.Location.    It may 
prove invaluable to users who have to keep track of different meetings/events that do not 
occur locally; or users who travel extensively.

Alarm On/Off
This check box is used to enable or disable an alarm for the event.

Alarm Time
Used to set the time of the alarm for the event.

Test
Plays the currently selected alarm.

Audio
This combo box is used to select the audio desired for the alarm.    External digital sound 
files can be associated with audio alarms using the Options/Sound... menu selection.

Until:
For recurring event types, this control is used to specify the ending date that the dialog 
parameters apply to.

Display on month
Check this box to have the event displayed in the Main calendar window in the month 
mode.    





     Changing a Scheduled Item

 

Almanac can change an individual schedule item, or a range of occurrences for a recurring 
scheduled item.
Recall the scheduled event by double-clicking wherever it appears in Almanac.    Make any 
changes that you wish in the Modify Schedule Item dialog.    Almanac will attempt to re-
schedule an event if changes are made to the time or date fields.

If you would like to change a range of events for a recurring schedule item, recall the first 
occurrence (the earliest date) that you wish to change.    When the Modify Schedule Item 
dialog appears, enter an End Date that will include the last occurrence that you wish to 
(re)schedule or change.    Almanac will always attempt to find existing occurrences of the 
event to update.    A new appointment will be scheduled whenever this search fails.



Entering Dates in Edit Controls

Using the mouse
This control has a drop-down operation to allow enhanced mouse and keyboard selection of 
dates. The control can be opened and closed with the normal drop-down commands of Alt-
Down Arrow and Alt-Up Arrow, or the mouse can be clicked on the control's arrow button.

Using the keyboard
Intelligent edit boxes have been created for entering dates into Almanac.    These edit 
controls do not require verbose entries such as Monday, December 25, 1995.    Much shorter 
entries such as "D 25" can be entered.    Almanac will expand this information when you 
move the cursor out of the edit control.

Format
The short and long date formats you have configured using Windows Control Panel 
(International Settings) are used to display and interpret all dates.

Almanac scans the text entered into a date edit control.    If alphabetic characters are found, 
the information is interpreted against the MDY order of the long format, otherwise the MDY 
order of the short format is used.    You can enter very short abbreviations when specifying a 
date.    For example, if your long format is MDY order, entering J 1 might be expanded to 
Sunday, January 1, 1995.

Alphabetic days in the long format are always ignored and adjusted to the correct day that 
the remaining information specifies.

The minimum information required is the date of the month.    The current month and year 
will be used when they are not specified in the entry.    Experiment with your own 
"shorthand" entries to find the style that you like best.



          Search Tool 
This window is to locate information that you have entered into Almanac, for easy recall.    
Invoke this window from the Window menu (F9).

Where...
Invokes the "Where To Search..." dialog to allow specific data areas and time ranges to be 
specified.The time range is saved in the ALMANAC.INI file so that subsequent searches will 
initialize to the same date range relative to the current date.    A search performed from one 
week in 
the past through two months in the future will automatically "slide" from one day to the next
so that the relative date range is maintained.

The default setting for the time range is +/- 30 days from the current date.    If the time 
range is changed, the following attempts will search the last time range specified.

Query:
The information that you need to find, is specified in this field.    Upon successful search 
attempts, a short list is built in the drop-down combo box for easy reference.

Find:
Upon pushing this button, the Search Tool will attempt to find the information specified in 
the Query field.

"Found" items are displayed in a formatted listbox below the search controls.    The
user may double-click or press Enter on the current highlighted item to immediately move 
to the entry in Almanac. The Search tool window will reduce its size and move to the edge of
the frame window to allow maximum viewing space when viewing the found item.    
Selecting the 
"Reopen" tool button will restore the Search window to allow further selections or searches.



       To-Do Tool Window

This window is used to track items which need to be fulfilled by a certain date (and 
optionally a time).    Invoke this window, from the Window menu (F6).

The To-Do window has a list box that contains to-do items.    Each item will display in the 
Main window in the day view mode on the date that it is due.

Any item that is not completed by its due date will automatically be displayed on 
subsequent dates in the Main window day view until it is completed.

Managing To-Do items
A new to-do item can be entered by clicking on the "+" tool button of the To-Do window tool 
bar, or by selecting Add from the To-Do menu.    Either action will activate the To-Do Item 
dialog.

The check mark tool button is used to mark the currently selected to-do item as being 
fulfilled or completed.    It can also be used to reset an item to incomplete.

The file cabinet tool button is used to archive the currently selected to-do item to the ASCII 
text file, TODO-HST.TXT.

To make changes to an existing item, double-click on the entry in the To-Do window listbox.    
Keyboard users can highlight the item in the list box and then select Modify from the To-Do 
menu.



         Create To-Do Item
See AlsoToDo Configuration

 

Text
Up to forty characters of text describing the to-do item.

Activate Date
The to-do item will become pending as of this date.    Can be used together with the View 
Pending option of the To-Do window to automatically post items in the list box beginning 
on their activation date.

Req'd By
The date (and optionally, the time) that this to-do item must be fulfilled by.

Time: (optional)
Used to set a time for the overlay event.    Once establishing a time, the Time Zone button 
will become active, so that you may specify a time zone different than the one set through 
Options.Location.    It may prove invaluable to users who have to keep track of different 
meetings/events that do not occur locally; or users who travel extensively.

Note:    Setting a time for an todo item will not activate an alarm.    To set an alarm for an 
event, you must enter it as a Schedule Item, through QuickEdit or    the Scheduler window.

Priority
Used to provide a relative priority level to each item on the list.    The To-Do list can be 
sorted by priority and required by date, or first by date and then priority.



Archive (to-do item)
Archiving a to-do item removes it from the To-Do window and creates an entry in the ASCII 
text file, TODO-HST.TXT.    The entry consists of the text of the item and the time and 
date completed.    Any notes attached to the item are deleted at this time (the notes are 
not archived).

Only completed items may be archived. To remove an incomplete item you must edit the 
item and select Remove.



Using the Tool Bar
See Also Keyboard Tips

The tool bar, a horizontal bar containing information windows and tool buttons, appears 
directly below Almanac's main menu. 

Date and time windows appear on the left side of the tool bar.    These areas always display 
the current time and date.

Tip:    Double-clicking on the surface of the tool bar is a mouse shortcut to reset Almanac to 
today's date.

Tool buttons appear to the right, grouped by function.    The first set of buttons control the 
Main window, followed by the tool window buttons, the prior/next buttons, and finally the 
tidy tool button.

Main Window buttons

  Year view button.    Places the Main window into year mode.

    Month view button.    Places the Main window into month mode.

    Day view button.    Places the Main window into day mode.

Tool Window buttons
The tool window buttons will activate a window for either the Scheduler, Notes, ToDo, 
Phonebook, or Search tool windows.    If the desired tool is behind other windows, it will be 
brought to the top.    If it is minimized to an icon, it will be restored.    If the tool does not yet 
exist as a window or icon, it will be created.

    Scheduler tool button (F5).

    ToDo tool button (F6).

    Phonebook tool button (F7).

    Notes tool button (F8).

  Search Tool button (F9).



Prior / Next buttons

    These buttons function on the currently active window.

Main window
The window is advanced or backed up according to its current mode (i.e., the calendar 
moves by month in month mode).

Note window
The buttons will change the date if the note window contains general notes, and 
schedule notes.    The buttons are not available for other note types.

Scheduler window
The buttons will change the date of the schedule.

Tidy button

    This button will reset the state of Almanac's desktop as it was last saved in the current 
config file (F10).





Contents for Almanac Help
If you would like to learn how to use Help, press F1.

        Almanac Basics
    This will help you become familiar with how Almanac operates.
      Where it stores data, and the files they are kept in.

        Menu Commands
    This will display the menus, and their commands.

        Tool Windows
    This will give you descriptions of all tool windows. 

        Reference Information
    The answers to frequently asked questions. 

                                    Helpful hints to make Almanac even easier to operate.




